
Experiment 9: Electromyogram (EMG) 
Activity in Antagonistic Muscles

Background
The movement of parts of the body is accomplished 

through a system of levers composed of skeletal 
muscles and bones. In a lever, the muscle attached to 
the bone provides the effort or force that moves the 
bone. As the muscle contracts and relaxes, the bone, 
functioning as the actual lever, rotates around a joint in 
the skeletal system. In relation to the muscle, the 
bone, and the body part being moved, the joint is the 
fixed point that functions as the fulcrum for the lever. 
The body part being moved is the load in the lever 
(Figure 3-1 on page 1). 

 Figure 3-1: A Third Class lever and a counterpart in the human body. The 
insertion of the muscle on the bone in the forearm places the effort between 
the wrist (fulcrum) and the hand load).

All levers, including the ones in the body, can be 
categorized into one of three classes, which are based 
on the position of the fulcrum in relation to the 
positions of the effort and the load:

• In First Class levers, the fulcrum is between the effort and 
the load, like on a see-saw. In the body, an example of this 
class is the extension of the forearm by the triceps muscle. 

• In Second Class levers, the load is between the effort and 
the fulcrum, like a wheel barrow. In the body, an example of 
this class is standing on tiptoe by using the gastrocnemius 
muscle.

• In Third Class levers, the effort is between the fulcrum and 
the load, like tweezers. In the body, an example is the flexion 
of the forearm by the biceps muscle.

Body parts are moved in different directions by 
muscles that act on the same bone from different 
directions. A simple example is the movement of the 
forearm. When the biceps muscle contracts, the 
forearm and the hand move toward the shoulder in a 
motion called flexion. When the triceps muscle 
contracts, the forearm and hand move away from the 
shoulder in a motion called extension. Since these two 
muscles move the forearm in different directions, they 
are antagonistic muscles. These muscles relax and 
contract in a coordinated manner to place the forearm 
and hand in the desired position. If the effort exerted 
on the bone by each muscle is equal in magnitude and 

opposite in direction, the forearm remains 
stationary.Even though they are antagonistic, the 
biceps and triceps muscles are from two different 
classes of levers. The biceps is part of a third class 
lever, and the triceps is part of a first class lever.

By recording the EMG activity in a muscle during the 
movement or positioning of a body part, it can be 
determined if the muscle is involved. In this exper-
iment, you will record EMG activity from muscles on 
the anterior and posterior sides of the forearm to 
determine which ones are responsible for flexion and 
extension of the hand. Recording of EMG activity from 
these muscles will also be done while a weight is lifted 
by the hand. In another exercise, you will EMG activity 
from the anterior and posterior sides of the lower leg to 
determine which muscles are active during movements 
or positioning that are more complex, like leaning 
forward, standing on toes, or rocking on heels. 

Equipment Required
PC Computer

iWorx unit, and USB or serial cable

AAMI cable and five EMG leads

Disposable electrodes

Small weight

Alcohol swabs

Equipment Setup
1 Connect the iWorx unit to the computer (described in 

Chapter 1).

2 Attach the AAMI connector on end of the EMG recording 
cable to the isolated Channel 1 and 2 inputs on the iWorx 
unit (Figure 3-2 on page 2).

3 Attach five color-coded snap leads to the Channel 1, 
Channel 2, and ground inputs on the lead pedestal.

Start the Software
1 Click the Windows Start menu, move the cursor to 

Programs and then to the iWorx folder and select 
LabScribe; or click on the LabScribe icon on the Desktop.

2 When the program opens, select Load Group from the 
Settings menu.   

3 When the dialog box appears, select AddedLabs.iws. 
Click Load.

4 Click on the Settings menu again and select the Antago-
nisticMuscles settings file.

5 After a short time, LabScribe will appear on the computer 
screen as configured by the AntagonisticMuscles 
settings.
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Exercise 1: Antagonistic Muscles in Forearm
Aim: To study the EMG activity in muscles that work in 

opposition to each other to flex or extend the hand.

Procedure

1 The subjects should remove all jewelry from their wrists.

2 Locate the muscles of the forearm over which the recording 
electrodes will be placed. Muscles can be located by flexing 
or extending the hand and noting the areas of the forearm 
where the muscles are tense during these hand positions:

• One pair of recording electrodes will be placed over the 
flexor muscles on the anterior surface of the forearm. The first 
electrode in this pair will be placed about 8 centimeters below 
the inside of the elbow and about 4 centimeters from the 
medial margin of the forearm. The second electrode in this pair 
will be placed about 8 centimeters below the other electrode 
along the midline of the anterior surface of the forearm.

• A second pair of electrodes will be placed over the extensor 
muscles on the posterior surface of the forearm. The first 
electrode in this pair will be placed about 9 centimeters below 
the tip of the elbow along the midline of the posterior surface of 
the forearm. The second electrode in this pair will be placed 
about 6 centimeters below the first electrode and about 3 centi-
meters from the lateral margin of the posterior surface of the 
forearm.

• A fifth electrode, used as the ground, is centered between 
the positions of the four recording electrodes.

3 Use an alcohol swab to clean and scrub the areas where 
the electrodes will be placed (Figure 3-2 on page 2). Let the 
areas dry before attaching the electrodes.

 Figure 3-2: Position of electrodes used to record EMG from muscles in the 
forearm during flexion and extension.

4 Remove the plastic disk from a disposable electrode and 
apply it to one of the scrubbed areas. 

5 Snap the recording lead wires onto the electrodes, so that:

• the red “+1” lead is attached to the electrode on the anterior 
forearm that is nearest the elbow.

• the black “-1” lead is attached to the electrode on the anterior 
forearm closest to the middle of the forearm.

• the white “+2” lead is attached to the electrode on the 
posterior forearm that is nearest the elbow.

• the brown “-2” lead is attached to the electrode on the 
posterior forearm closest to the middle of the forearm.

• the green “C” lead (the ground) is attached to the electrode in 
the center of the box formed by the positions of the four 
recording electrodes.

6 Instruct the subject to do the following:

• Before the recording begins, the subject should extend his or 
her arm in front of their body with the palm facing upward. This 
position is defined as the neutral position. 

• Keep his or her hand open during the recording.

• Move his or her hand upward (flexion) from the neutral 
position as far as possible and hold it in this position for two 
seconds (Figure 3-3 on page 2).

 Figure 3-3: Movements performed while recording from muscles of the 
forearm responsible for flexion and extension of the hand.

• Return the hand to the neutral position for two seconds.

• Move the hand downward (extension) as far as possible and 
hold it in this position for two seconds.

• Return the hand to the neutral position for two seconds.

7 Repeat the cycle of flexion and extension two or three more 
times.

8 When the subject is ready to do the exercise, click Start. 
Click AutoScale on all channels to amplify signals. Mark 
the recording to indicate when the subject’s hand was 
flexed, extended, or in the neutral position. When the last 
cycle is completed, click Stop to halt recording.

9 Repeat the exercise described in Steps 6 and 7, but while 
the subject has his or her fist closed.

10 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file(e.g. the iWorx or class folder). Click the Save button to 
save the file (as an *.iwd file).

Data Analysis

1 Scroll to the data where the EMG activity of the anterior and 
posterior forearm muscles was recorded while the fingers 
were extended (Figure 3-4 on page 3).

2 Adjust the time displayed on the Main window to display the 
three bursts of EMG activity from both the anterior and 
posterior muscles on the screen at the same time. Use the 
Display Time icons on the LabScribe toolbar (Figure 3-5 on 
page 3), or the Display Time box on the Channels page of 
the Preferences dialogue window on the Edit menu, to set 
the proper screen width. Click OK.
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 Figure 3-4: Recordings from anterior (top) and posterior (second from the 
top) muscles of the forearm during flexion and extension, while the subject’s 
fingers are extended. The absolute integrals of EMG activity from the anterior 
and posterior muscles are displayed on the third and fourth channels.

3 Click the 2-cursor icon on the toolbar (Figure 3-5 on page 
3). Place the two cursors on the Main window so that at 
least three EMG bursts from each EMG channel (Channels 
1 and 2) are included between the two cursors.

 Figure 3-5: The LabScribe toolbar.

4 Click the Analysis icon to open the Analysis window. 
Display all channels. Select IntegralAnt from the Value 
from Ch list on the left side of the Analysis window, a 
Precision of 5, and Title and Area from the Table 
Functions list.

5 Drag one cursor to the beginning of the absolute integral of 
the first EMG burst and the second cursor to the end of the 
integral of that burst. The Area under the plot of the 
absolute integral for the burst is a measure of the relative 
strength of the EMG activity during the contraction of the 
muscles in the anterior forearm.

6 This data can be entered into the Journal by either typing 
the titles and values directly or by using the right-click 
menu. Place the cursors to take measurements; then, 
select Add Title to Journal or Add Data to Journal from 
the right-click menu to add the measurements to the 
Journal.

7 Repeat Steps 5 and 6 to measure and record the Area 
under the absolute integrals of the two additional EMG 
bursts from the muscles in the anterior forearm. Average the 
values of the Area for these three bursts and record the 
mean in the Journal and on Table 3-1 on page 4.

8 Select IntegralPost from the Value from Ch list on the left 
side of the Analysis window. Use the same technique 
described in Steps 5, 6, and 7 to measure and record the 
Area under the absolute integrals of the three EMG bursts 
recorded from the muscles of the posterior forearm. 

Average the values of the Area for these three bursts and 
record the mean in the Journal and on Table 3-1 on page 4.

Questions

1 Which muscles, anterior or posterior, had the most 
EMG activity during flexion?

2 Which muscles, anterior or posterior, had the most 
EMG activity during extension?

3 Does flexion or extension of the fingers affect the 
strength of EMG activity in either group of muscles?

Exercise 2: Antagonistic Muscles Doing Work
Aim: To study the EMG activity in muscles that lift 

weight by flexion or by extension.

Procedure

1 Use the same experimental setup used in Exercise 1.

2 Instruct the subject to rest his or her forearm, with the 
electrodes, on a flat surface with the palm up.

3 Place a weight (2-3kg) in the palm of the subject’s hand 
(Figure 3-6 on page 3).

 Figure 3-6: Hand in the palm-up position for lifting the weight by flexion (on 
the left), and the hand in the palm-down position for lifting the weight by 
extension (on the right).

4 Click Start. Record the EMG activity from the muscles of 
the forearm as the subject lifts the weight by the flexion. The 
subject should raise and hold the weight up for two seconds 
and then return the weight to the table top for two seconds. 
Repeat this cycle two or three more times. Click Stop to halt 
the recording.

5 Instruct the subject to rest his or her forearm on a flat 
surface with the palm down (Figure 3-6 on page 3).

6 Have the subject grip the same weight (2-3kg).

7 Click Start. Record the EMG activity from the muscles of 
the forearm as the subject lifts the weight by extension. The 
subject should raise and hold the weight up for two seconds 
and then return the weight to the table top for two seconds. 
Repeat this cycle two or three more times. 

8 Click Stop to halt the recording.

9 Select Save in the File menu.

Data Analysis

1 Scroll to the data where EMG activity was recorded from the 
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anterior and posterior forearm muscles while a weight was 
lifted by flexion (Figure 3-7 on page 4).

 Figure 3-7: EMG activity during the lifting of a weight by flexion and 
extension: anterior muscles during flexion (top); posterior muscles during 
flexion (2nd from the top); anterior muscles during extension (3rd from the 
top); and, posterior muscles during extension (bottom).

2 Use the same procedures used in Exercise 1 to measure 
and record the relative strengths of the EMG bursts while 
the weight was lifted by flexion and by extension.

3 Enter the means in Table 3-1 on page 4.

Questions

1 Does the strength of the EMG activity in the muscles of the 
anterior forearm differ between flexion with a weight and 
without a weight?

2 Does the strength of the EMG activity in the muscles of the 
posterior forearm differ between extension with a weight 
and without a weight?

Exercise 3: Antagonistic Muscles in Lower Leg
Aim: To study muscles working in opposition to each 

other to maintain balance while standing.

Procedure

1 Locate the muscles of the lower leg over which the 
recording electrodes will be attached. Muscles can be 
located by performing dorsiflexion or plantar flexion of the 
foot and noting the areas of the lower leg where the 
muscles are tense during each flexion:

• One pair of recording electrodes will be placed over the 
anterior tibialis muscle. This muscle is located just lateral to the 
tibia (shinbone) in the upper part of the calf (Figure 3-8 on 
page 5). To locate the tibialis anterior, feel for the subject's 
tibia. Place your fingers 2 cm to the lateral side of the margin 
of the tibia and 8-12 cm below the kneecap. As the subject 
points his or her foot inward (supination) and upward (dorsi-
flexion) their foot, you should be able to see and feel the 
contraction of the anterior tibialis muscle beneath the skin. The 
first electrode in this pair will be placed about 10 centimeters 
below the knee on the midline of the muscle. The second 
electrode in this pair will be placed on the midline of the 
muscle, about 10 centimeters below the first electrode.

• A second pair of recording electrodes will be placed over the 
gastrocnemius (calf) muscle on the back of the lower leg. The 
first electrode in this pair will be placed about 8 centimeters 
below the back of the knee, along the midline of the calf 
muscle. The second electrode in this pair will be placed in the 
middle of the calf muscle along its midline, about 10 centi-
meters below the first electrode.

• A fifth electrode, used as the ground, is placed on the inside 
of the lower leg just above the ankle. 

2 Use an alcohol swab to clean and scrub the areas where 
the electrodes will be placed (Figure 3-8 on page 5). Let the 
areas dry before attaching the electrodes.

3 Remove the plastic disk from a disposable electrode and 
apply it to one of the scrubbed areas. 

4 Snap the recording lead wires onto the electrodes, so that:

• the red “+1” lead is placed on the electrode in the upper 
portion of the tibialis anterior.

• the black “-1” lead is placed on the electrode in the middle 
portion of the tibialis anterior.

• the white “+2” lead is attached to the electrode near the back 
of the knee.

• the brown “-2” lead is attached to the electrode in the middle 
of the calf muscle. 

• the green “C” lead (the ground) is attached to the electrode 
above the ankle.

5 While the subject is sitting, click Start. Have the subject 
alternate between plantar flexion and dorsiflexion of their 
foot. Click AutoScale on all channels to amplify signals. 
Click Stop.

Table 3-1:

Area under the Absolute Integral  of  
the EMG Bursts for  the Listed 

Act ions ( in V.secs)

Forearm Act ion Anter ior  Muscles Poster ior  Muscles

Flexion,
Hand Open

Extension,  
Hand Open

Flexion,  
Fist  Closed

Extension,  
Fist  Closed

Flexion,  
L i f t ing Weight

Extension,  
L i f t ing Weight
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6 Have the subject stand erect. Click Start. Have the subject 
rock on their feet from heels to toes and back to heels, 3 or 
4 times. Notice the alternating contractions of the gastroc-
nemius and anterior tibialis muscles when the subject rocks 
forward and backward.

 Figure 3-8: Position of electrodes used to record EMG from muscles in the 
lower leg during plantar flexion and dorsiflexion.

7 Have the subject rock backward and forward, 3 or 4 times, 
while putting more weight on the leg with the electrodes. 
Even though one muscle may dominate the record, the 
other muscle is also somewhat active.

8 Have the subject stand on one foot and remain motionless. 
Co-contraction of the antagonistic muscles mechanically 
stabilizes the joints when the subject is motionless. The 
stretch reflexes prevent twisting and slipping and help to 
maintain balance.

9 Joint stabilization is particularly important to leg and postural 
muscles involved in bipedal locomotion. Within the limits of 
artifacts induced by leg movement and cable lengths, 
explore the activity of the ankle flexors. Have the subject 
either squat or stretch upward on his/her toes.

10 Click Stop to halt recording.

11 Select Save in the File menu.

Data Analysis

1 Scroll to the data where EMG activity was recorded from the 
muscles of the anterior and posterior lower leg (Figure 3-9 
on page 5).

2 Use the same procedures used in Exercise 1 to measure 
and record the relative strengths of the three EMG bursts 
from anterior and posterior muscles while the subject 
moved his or her legs and body in different directions: 

• Standing erect on both legs;

• Rocking back and forth on both legs;

• Rocking back and forth on the leg with the electrodes;

• Standing erect on the leg with the electrodes;

• Ankle flexing by squatting or standing on the toes

 Figure 3-9: Recordings from anterior (top) and posterior (second from the 
top) muscles of the lower leg while the subject is leaning forward and 
backward. The absolute integrals of EMG activity during these flexions 
(plantar and dorsi) are displayed on the third and fourth channels.

Questions

1 Compare the Areas of the EMG integrals from the tibialis 
anterior during each of the activities. When was tibialis 
anterior activity the greatest? The least?

2 Compare the Areas of the EMG integrals from the gastroc-
nemius during each of the activities. When was gastroc-
nemius activity the greatest? The least?

3 How does EMG activity in the gastrocnemius correlate to 
EMG activity in the tibialis anterior?
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